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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your

safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy

place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-

able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-

ating the machine.

Caution:

Use of controls or adjustments or performance of procedures other than those specified in this manual

might result in hazardous radiation exposure.

Notes:

The model names of the machines do not appear in the following pages. Check the type of your ma-

chine before reading this mamual.

• Type1: Resolution 600 dpi

• Type2: Resolution 400 dpi

Two kinds of size notation are employed in this manual.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the

United States and/or other countries.

Adobe®, PostScript®, Acrobat® and PageMaker® are registered trademarks of Adobe Systems Incor-

porated.

AppleTalk, Apple, Macintosh and Mac OS are registered trademarks of Apple Computer, Incorporated.

IPS-PRINT™ Printer Language Emulation Copyright© 2000, Oak Technology, Inc., All Rights Re-

served.

Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows® 95

• The product name of Windows® 98 is Microsoft® Windows® 98

• The product name of Windows® Me is Microsoft® Windows®  Millennium Edition (Windows Me)

• The product name of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Professional

• The product name of Windows® XP are as follows:

Microsoft® Windows® XP Professional

Microsoft® Windows® XP Home Edition

• The product names of Windows ServerTM 2003 are as follows:

Microsoft® Windows ServerTM 2003 Standard Edition

Microsoft® Windows ServerTM 2003 Enterprise Edition

Microsoft® Windows ServerTM 2003 Web Edition

• The product name of Windows® NT are as follows:

Microsoft® Windows NT® Server 4.0

Microsoft® Windows NT® Workstation 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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Manuals for This Machine

The following manuals describe the operational procedures of this machine. For
particular functions, see the relevant parts of the manual.

Note

❒ Manuals provided are specific to machine type.

❒ Adobe Acrobat Reader/Adobe Reader is necessary to view the manuals as a
PDF file.

❖ Safety Information (paper)
Describes information about the safety precautions.

❖ Easy Operation Guide (paper/PDF file - CD-ROM *1 )
Describes information about the control panel and basic operations.

❖ Operating Instructions (PDF file - CD-ROM *1 )
Describes operations, functions, User Tools (initial setting, mode setting, etc.)
and troubleshooting.

❖ Network Guide (PDF file - CD-ROM *1 )
Describes procedures for configuring the machine and computers in a net-
work environment.

❖ Printer Reference (this manual) 
Describes system settings and operations for the machine's printer function.

❖ Preparations for Use as a Printer (paper/PDF file - CD-ROM *1 )
Describes procedures for connecting the Ethernet and USB cables to the ma-
chine.

❖ Manuals for DeskTopBinder Lite
DeskTopBinder Lite is a utility included on the CD-ROM labeled “Document
Management Utility”.

• DeskTopBinder Lite Setup Guide (PDF file - CD-ROM *2 ) 
Describes the installation of, and the operating environment for DeskTop-
Binder Lite in detail. This guide can be displayed from the [Setup] dialog
box when DeskTopBinder Lite is installed.

• DeskTopBinder Lite Introduction Guide (PDF file - CD-ROM *2 ) 
Describes operations of DeskTopBinder Lite and provides an overview of
its functions. This guide is added to the [Start] menu when DeskTopBinder
Lite is installed.

❖ Other manuals

• PostScript3 (PDF file - CD-ROM *1 )
*1 Provided on the CD-ROM labeled “Operating Instructions”
*2 Provided on the CD-ROM labeled “Document Management Utility”



ii

TABLE OF CONTENTS

Manuals for This Machine ...................................................................................... i

How to Read This Manual .....................................................................................1

1. Getting Started

Control Panel..........................................................................................................3
Display Panel .............................................................................................................5
Printer Settings...........................................................................................................6

2. Preparing to Print

Connecting the Machine .....................................................................................12
Requirements...........................................................................................................13
Using the Parallel Cable...........................................................................................13
Using IEEE 802.11b (Wireless LAN)........................................................................14

User Tools Menu (System Settings)...................................................................17
Interface Settings .....................................................................................................18
Network Configuration..............................................................................................19
Settings You Can Change with User Tools..............................................................21

Installing the Software.........................................................................................25
Auto Run ..................................................................................................................25
Quick Install..............................................................................................................26
Installing RPCS Printer Driver..................................................................................28
Setting Up Options - RPCS......................................................................................33
Installing the PostScript 3 Printer Driver ..................................................................34
Mac OS - Installing the PostScript 3 Printer Driver and Utilities...............................41
Mac OS X - Installing the PostScript 3 Printer Driver...............................................43
Installing the Printer Driver Using USB ....................................................................44
Installing SmartDeviceMonitor for Client/Admin.......................................................47
Using Adobe PageMaker Version 6.0, 6.5, or 7.0....................................................48

Software and Utilities Included on the CD-ROM...............................................49
Printer Drivers ..........................................................................................................49
Software and Utilities ...............................................................................................50

3. Setting Up the Printer Driver and Canceling a Print Job

Accessing Printer Properties..............................................................................51
Windows 95/98/Me - Accessing Printer Properties ..................................................51
Windows 2000/XP and Windows Server 2003 - Accessing Printer Properties ........52
Windows NT 4.0 - Accessing Printer Properties ......................................................54
Macintosh - Setting Up for Printing ..........................................................................56

Canceling a Print Job ..........................................................................................57
Canceling from a computer ......................................................................................57
Canceling on the control panel.................................................................................58



iii

4. Various Types of Printing

Windows 95/98/Me - Various Types of Printing ................................................59
Printing on custom sized paper................................................................................59
Printing on paper with an undetectable size ............................................................60
When envelopes cannot be fed................................................................................61

Windows 2000/XP and Windows Server 2003 - Various Types of Printing ....63
Printing on custom sized paper................................................................................63
Printing on paper with an undetectable size ............................................................64
When envelopes cannot be fed................................................................................65

Windows NT 4.0 - Various Types of Printing.....................................................67
Printing on custom sized paper................................................................................67
Printing on paper with an undetectable size ............................................................68
When envelopes cannot be fed................................................................................69

5. Troubleshooting

Error & Status Messages on the Display Panel ................................................71

Printer does not Print ..........................................................................................73

Other Printing Problems .....................................................................................76

6. Using the Control Panel

Online Print Features Menu ................................................................................83

Adjusting Online Print Features .........................................................................84

Online Print Features Settings ...........................................................................85
General Features .....................................................................................................85
List / Test Print .........................................................................................................86
Host Interface...........................................................................................................89
PS Menu ..................................................................................................................89
Administrator Tools ..................................................................................................89

7. Appendix

Printing a PDF File Directly.................................................................................91
Printing Method ........................................................................................................91

Specifications.......................................................................................................93
Options.....................................................................................................................94

INDEX......................................................................................................... 96



iv



1

How to Read This Manual

Symbols

The following set of symbols is used in this manual.

R WARNING:

This symbol indicates a potentially hazardous situation that might result in
death or serious injury when you misuse the machine without following the in-
structions under this symbol. Be sure to read the instructions, all of which are de-
scribed in the Safety Information section.

R CAUTION:

This symbol indicates a potentially hazardous situation that might result in mi-
nor or moderate injury or property damage that does not involve personal injury
when you misuse the machine without following the instructions under this
symbol. Be sure to read the instructions, all of which are described in the Safety
Information section.

* The statements above are notes for your safety.

Important

If this instruction is not followed, paper might be misfed, originals might be
damaged, or data might be lost. Be sure to read this.

Preparation

This symbol indicates information or preparations required prior to operating.

Note

This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

Reference

This symbol indicates a reference.

[ ]

Keys that appear on the machine's display panel.

[ ]

Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.

{ }
Keys on the computer's keyboard.
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Names of Major Options

Major options of this printer are referred to as follows in this manual:

• IEEE 1284 Parallel Board Type 1 → IEEE 1284 parallel board

• IEEE 802.11b I/F Unit Type 1 → IEEE 802.11b interface unit

• PostScript3 Board Type 2 → PostScript board

• Extension HDD Type 1 → HDD board

The following software product is referred to using a general name:

• DeskTopBinder Lite and DeskTopBinder professional → DeskTopBinder
Lite/professional
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1. Getting Started

Control Panel

1. Screen contrast knob

Adjusts the brightness of the display panel.

2. {Image Position} key

Adjusts the position of printed images.

3. {User Tools} key

Press to change the default settings to
meet your requirements.

4. Position Setting keys

Adjusts the position of printed images.

5. {Printer Settings} key

Press to change the default settings of on-
line printing.

6. Indicators

7. {Check Modes} key

Press this key to check settings.

8. {Program} key 

Press to register frequently used settings,
or to recall registered settings.

9. {Clear Modes} key

Press to clear previously entered copy job
settings.

10. {Hold Data-in} key

Press to reject the online print temporarily.

11. {Master Making} mode select key

Press to select the master making mode.

12. {Auto Cycle} key

Press to make masters and prints in a sin-
gle operation. 

13. {Print} mode select key

Press to select the print mode.

14. Main power indicator 

The main power indicator lights up when
the main power switch is turned on.

15. {Proof} key

Press to make a proof print.

Same as 22.

16. Data In indicator (Green)

• On: Data waiting for Master Making
and printing is in the machine.

• Blinking: Data is being received, or
Master Making or printing is in
progress.

• Off: Master Making and printing are
completed.

17. Error indicator (Red)

• On: An error has occurred. Master
Making and printing stops.

• Off: Normal status

AJK101S
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18. Speed setting keys

Press to adjust the printing speed.

19. {Initial position} key

Press to reset to the default image posi-
tion.

20. Number keys

Press to enter the desired number of
prints and data for selected modes.

21. {Clear/Stop} key

• Clear
Press to delete a number entered.

• Stop
Press to stop a job in progress.

22. {Proof} key

Press to make a proof print.

Note

❒ Same as 15.

23. {Start} key

Press to start making masters or printing.

24. Operation switch

Press this switch to go into the Energy
Saver mode. Press again this switch to re-
turn to ready condition.
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Display Panel

The display panel shows machine status, error messages and function menus.

The function items displayed serve as selector keys. You can select or specify an
item by lightly pressing them.

When you select or specify an item on the display panel, it is highlighted like
. Keys appearing as  cannot be used.

Important

❒ A force or impact of more than 30 N (about 3 kgf) will damage the display
panel.

By default the screen is displayed when you turn the power on.

Common Key Operations

The display panel shows the printer status, error message, and function menu.

1. Printer status or messages

Displays current machine condition.

2. Number of prints made.

3. [End Printing] key

Press to cancel the current master making
or printing. See p.7 “Selecting the Cycle
Setting Mode”

4. [Job Reset] key

Press to cancel the current job.

Seep.57 “Canceling a Print Job”

5. [Make Master Options] key

Press to set the optional functions of
making master.

Reference

See Operating Instructions.

6. Function keys

Reference

See Operating Instructions.

AJK171S
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❖ Key list

Printer Settings

It is possible to change the paper size, cycle setting mode on the Printer Settings
menu.

Selecting the Online Print Paper Size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size depending on the paper size. In these
cases, follow the procedure below and manually make the desired settings.

A Press the {Printer Settings}key on the printer.

B Press [Tray Paper Size: Paper Feed Tray].

C Select the paper size, and then press [OK].

Important

❒ Select a size that is bigger than the contents to be printed. If the contents
are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

D Press [Exit].

[OK] Acknowledges a selected function or entered values, and then returns 
to the previous display

[Cancel] Deletes a selected function or entered values, and then returns to the 
previous display

[UPrev.], [TNext] Moves to the previous page or the next page when all functions cannot 
be displayed on one page.

[OK] [Yes] Closes displayed messages.

[Clear] Clears entered values and does not change the settings.

[Exit] Returns to the previous display.

AJK136S
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Selecting the Cycle Setting Mode

It is possible to set the operation mode when executing master making and
printing online.

A Auto Cycle

Master making and printing of all pages are executed continuously.
If printing is suspended using the {Clear/Stop} on the control panel, it stops in
the print mode.
In this case, it is not possible to switch to the master making mode unless
printing is completed.
To resume master making from the next page, press the [End Printing] on the
display and terminate the printing operation.

B Original Page Cycle

Operations tentatively stop after master making and printing of each page are
executed in succession.
It switches to the master making mode with printing terminated. Press the
{Start}on the control panel while in this state to resume master making from
the next page.

Note

❒ Since it switches to the master making mode when printing is concluded,
switch to the print mode and press the {Start} on the control panel to exe-
cute additional printing with printing in the concluded state.

AJK172S
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C Master Cycle

It tentatively stops for each master making of each page.
The master making of the following page subsequent to printing starts in suc-
cession and stops after the conclusion of master making.
It switches to the print mode with master making in the concluded state.
Press the {Start} on the control panel to start printing.

Note

❒ Since it switches to the print mode when master making concludes, to pro-
ceed to the master making of the next page without printing the master
making page, press the [End Printing] on the display and conclude the print
mode.

D Master/Print Cycle

It tentatively stops for each master making and printing of each page.
It switches to the print mode with master making in the concluded state.
Press the {Start} on the control panel to start printing. It switches to the master
making mode with printing in the concluded state.
Press the {Start} on the control panel in this state to resume master making
from the next page. 

Note

❒ Since it switches to the master making mode when printing is concluded,
switch to the print mode and press the {Start} on the control panel to exe-
cute additional printing with printing in the concluded state.

AJK174S

AJK173S



Control Panel

9

1

A Press the {Printer Settings} key.

B Press the [Cycle Setting] .

C Select the Cycle Setting Mode, and then press [OK].

D Press the [Exit].

AJK136S
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2. Preparing to Print

This section gives instructions for connecting the printer and computer, config-
uring the printer, and installing software.

❖ When operating the printer with a USB or a parallel connection

• Connect the printer and computer using a USB or a parallel connection.

Reference

For more information about connection using the USB, see Preparations
for Use as a Printer.

For more information about connection using the parallel cable, see p.12
“Connecting the Machine”.

• Install a printer driver from the CD-ROM labeled "Printer Drivers and Util-
ities".

Reference

For more information, see p.25 “Installing the Software”.

❖ When operating the printer under a network environment

• Configure the network using the machine's control panel.

Reference

For more information, see p.17 “User Tools Menu (System Settings)”.

For information about connection using Ethernet, see Preparations for
Use as a Printer.

For information about connection using wireless LAN, see p.12 “Con-
necting the Machine”.

• Install a printer driver and other utilities from the CD-ROM labeled "Print-
er Drivers and Utilities".

Reference

For more information, see p.25 “Installing the Software”.

Note

❒ “Network environment” describes a situation where the printer is connected
to a computer via wireless LAN.

❒ The IEEE 1284 parallel board for parallel connection and the IEEE 802.11b in-
terface unit for wireless LAN connection cannot be used at the same time.

❒ Wireless LAN and parallel connection are optional functions.
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Connecting the Machine

1. USB port

Use a USB cable to connect the printer to
the host computer.

2. Ethernet port

Use a network interface cable to connect
the printer to a network.

3. Parallel interface port

Connector for the parallel interface cable
used when connecting to a computer.

4. IEEE 802.11b (wireless LAN) in-
terface port

Use to install the IEEE 802.11b interface
unit for wireless LAN connection to the
network.

Reference

For details about connection using
USB and Ethernet, see Preparations
for Use as a Printer.

AJK204S
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Requirements

Before using this printer, make sure all environmental and electrical require-
ments are met. Connect the printer to the host computer using the parallel port,
network interface unit, or both.

Make sure all cables, connectors, and electrical outlets necessary to attach the
printer to the host computer or network are at hand.

Important

❒ The interface cable is not supplied. It is your responsibility to prepare the in-
terface cable appropriate for the computer that you are using.

Using the Parallel Cable

Connect the printer to the host computer using a parallel cable compliant with
IEEE 1284 (available separately).

Follow these steps to connect the printer to the host computer.

Important

❒ Before connecting an interface cable between the printer and a computer,
make sure that the printer is not operating, and then turn off the main power
switches of the printer and the computer.

A Attach the parallel cable to the parallel interface connector of the printer,
and then secure the cable.

B Attach the other end of the parallel cable to the port of the computer. Secure
the cable.

ACV014S
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Using IEEE 802.11b (Wireless LAN)

Setting IEEE 802.11b (Wireless LAN)

Note

❒ Select [802.11 Ad hoc] as the communication mode when connecting Windows
XP as a wireless LAN client using Windows XP standard driver or utilities, or
when not using the infrastructure mode.

ACV010S
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Confirming the Connection

AMake sure the LED of the IEEE 802.11b card is lit.

❖ When using in infrastructure mode

1. If [LAN Type] on the [Interface Set-
tings]/[Network] screen is not set to
[IEEE 802.11b], this LED does not
light, even if the main power is on.

2. If the printer is connected proper-
ly to the network, the LED is green
when in infrastructure mode. If the
LED is blinking, the printer is
searching for devices.

❖ When using in ad hoc mode/802.11 ad hoc mode

1. If the IEEE 802.11b card is work-
ing, it is lit in orange.

2. If the printer is connected proper-
ly to the network, the LED is green
when in ad hoc mode or 802.11 ad
hoc mode. If the LED is blinking, the
printer is searching for devices. The
LED will light after a few seconds.

B Print the configuration page to verify settings.

Reference

For more information about printing a configuration page, see p.87 “Print-
ing the configuration page”.

ZGDH600J

1
2

ZGDH600J

1
2
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Checking the machine's radio wave status

When using in infrastructure mode, you can check the machine's radio wave sta-
tus using the control panel.

Note

❒ To check the radio wave status, press [IEEE 802.11b] under [LAN Type] on the
[Network] screen.

A Press the {User Tools} key.

B Press [System Settings].

C Press [Interface Settings].

D Press [IEEE 802.11b].

E Press [Wireless LAN Signal].

The machine's radio wave status appears.

F After checking radio wave status, press [Exit].

G Press the {User Tools} key to return to the User Tools menu.

AJK135S
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User Tools Menu (System Settings)

This section describes the network settings you can change with User Tools (Sys-
tem Settings). Make settings according to functions you want to use and the in-
terface to be connected.

Important

❒ These settings should be made by the systems administrator, or after consult-
ing with the systems administrator.

❖ Viewing the Information Displayed in the List
$ These items must be set to use the function. Be sure to set them before at-
tempting to use the corresponding function.
For details about settings, see p.21 “Settings You Can Change with User
Tools”
❍ These items must be set if required.
For details about settings, see "Settings You Can Change with User Tools",
Network Guide.
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Interface Settings

*1 Check [Active] is selected for TCP/IP.
*2 Appears when the IEEE 802.11b interface unit is installed.

If Ethernet and IEEE 802.11b (wireless LAN) are both connected to the printer, the
selected interface has priority.

Interface Settings

Ethernet Interface Set-
tings/Network

See p.21 “Interface 
Settings/Network”.

IP Address $

Gateway Address ❍

NW Frame Type ❍

Effective Protocol *1 $

Ethernet Speed ❍

LAN Type *2 $

IEEE 802.11b (wire-
less LAN)

Interface Set-
tings/Network

See p.21 “Interface 
Settings/Network”.

Interface Set-

tings/IEEE 802.11b *2 

See p.23 “Interface 
Settings/IEEE 
802.11b”.

IP Address $

Gateway Address ❍

Effective Protocol *1 $

NW Frame Type ❍

Ethernet Speed ❍

LAN Type *2 $

Communication Mode $

SSID Setting ❍

Channel ❍

WEP (Encryption) Setting ❍

Wireless LAN Signal ❍

Transmission Speed ❍
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Network Configuration

Any change you make with User Tools remains in effect even if the main power
switch or operation switch is turned off, or if the {Clear Modes} key is pressed.

Configuring the network using the control panel

Note

❒ Operations for System Settings are different from normal operations. After
using User Tools, press the {User Tools} key to exit.

❒ If the key operator code has been set, the key operator code entry screen ap-
pears. Enter the code, and then press the [OK] key. For details about the key
operator code, see Operating Instructions.

A Press the {User Tools} key.

B Press [System Settings].

C Press [Interface Settings].

D Select the setting you want to change, and then press [OK].

E Change the setting, and then press [OK].

Note

❒ To cancel changes made to settings and return to the System Settings
menu, press [Cancel].

F Press [Exit].

G Press the {User Tools} key.

Note

❒ You can also exit by pressing [Exit] on the User Tools main menu.

AJK135S
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Configuring the network using other utilities

In addition to the control panel, Web Image Monitor and SmartDeviceMonitor
for Admin can also be used for configuring the network. The following table
shows available settings:

Note

❒ ❍ Indicates printer settings can be changed.

❒ - Indicates the setting cannot be changed from that device.

*1 You can make the TCP/IP settings if SmartDeviceMonitor for Admin is communi-
cating with the printer using IPX/SPX.

*2 You can make the IPX/SPX settings if SmartDeviceMonitor for Admin is communi-
cating with the printer using TCP/IP.

Name on the control panel
Web Im-
age Mon-

itor

SmartDe-
viceMon-

itor for 
Admin

telnet

Interface Network DHCP ❍ ❍ ❍

IP Address ❍ ❍ ❍

Subnet Mask ❍ ❍ ❍

Gateway Address ❍ ❍ ❍

NW 
Frame 
Type

Auto ❍ - ❍

EthernetII ❍ - ❍

Ethernet802.2 ❍ - ❍

Ethernet802.3 ❍ - ❍

EthernetSNAP ❍ - ❍

Active 
Protocol

TCP/IP - ❍ *1 ❍

NetWare ❍ ❍ *2 ❍

SMB ❍ ❍ ❍

AppleTalk ❍ ❍ ❍

Ethernet Speed - - -

LAN 
Type

Ethernet ❍ - ❍

IEEE 802.11b ❍ - ❍

IEEE 
802.11b

Comm. Mode ❍ - ❍

Channel ❍ - ❍

Trans. Speed - - ❍

SSID ❍ - ❍

WEP Encryption ❍ - ❍

WEP Key ❍ - ❍



User Tools Menu (System Settings)

21

2

Settings You Can Change with User Tools

Interface Settings/Network

❖ IP Address
Before using this machine in the network environment, you must configure
the IP address and subnet mask.

• Auto-Obtain (DHCP)

• Specify
When you select [Specify], enter the [IP Address]and [Sub-net Mask] as
“xxx.xxx.xxx.xxx”(“x” indicates a number).

• IP Address: 011.022.033.044

• Sub-net Mask: 000.000.000.000

Note

❒ Default: Auto-Obtain (DHCP)

❒ When you select [Specify], be sure not to set the same [IP Address] as that of
another machines on the network.

❒ The physical address (MAC address) also appears.

❖ Gateway Address
A gateway is a connection or interchange point between two networks. Con-
figure the gateway address for the router or host computer used as a gateway.

• Gateway Address:000.000.000.000

Note

❒ Default: 000.000.000.000

❖ Effective Protocol
Select the protocol to use in the network.

• TCP/IP:Effective/Invalid

• NetWare:Effective/Invalid

• SMB:Effective/Invalid

• AppleTalk:Effective/Invalid

Note

❒ Default: TCP/IP: Effective, NetWare: Effective, SMB: Effective, AppleTalk: Effec-
tive
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❖ NW Frame Type
Select the frame type when you use NetWare.

• Auto Select

• Ethernet II

• Ethernet 802.2

• Ethernet 802.3

• Ethernet SNAP

Note

❒ Default: Auto Select

❖ Ethernet Speed
Set the access speed for networks.
Select a speed that matches your network environment. [Auto Select] should
usually be selected.

• Auto Select

• 100Mbps Fixed

• 10Mbps Fixed

Note

❒ Default: Auto Select

❖ LAN Type
When you have installed the optional IEEE 802.11b interface unit, select inter-
face, IEEE 802.11b (wireless LAN) or Ethernet.

• Ethernet

• IEEE 802.11b

Note

❒ Default: Ethernet

❒ Appears when the optional IEEE 802.11b interface unit is installed.

❒ If Ethernet and IEEE 802.11b (wireless LAN) are both connected to the ma-
chine, the selected interface takes precedence.
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Interface Settings/IEEE 802.11b

Preparation

You must install the IEEE 802.11b interface unit into the printer.

Note

❒ Be sure to make all settings.

❖ Communication Mode
Specifies the communication mode of the wireless LAN.

• 802.11 Ad hoc

• Ad hoc

• Infrastructure

Note

❒ Default: 802.11 Ad hoc

❖ SSID Setting
Specifies SSID to distinguish the access point in infrastructure mode or 802.11
ad hoc mode.

Limitation

❒ The characters that can be used are ASCII 0x20-0x7e (32 bytes).

Note

❒ Default: blank (ASSID)

❒ If blank is specified in 802.11b ad hoc mode or ad hoc mode, “ASSID” appears.

❖ Channel
Specifies a channel when you select 802.11b ad hoc mode or ad hoc mode.

Note

❒ Default: 11

❒ The following channels are available:

• Metric version: 1-13

• Inch version: 1-11
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❖ WEP (Encryption) Setting
Specifies the encryption of the IEEE 802.11b (wireless LAN). If this is set to
[Active], you must enter the WEP key.

• VWEP

• Active

• Inactive

• VEncryption
10 alphanumeric characters must be entered for 64 bit, 26 characters for 128
bit.

Note

❒ Default: Inactive

❖ Wireless LAN Signal
Shows the radio wave conditions of the access point connected in infrastruc-
ture mode.

Note

❒ Radio wave status is displayed when you press [Wireless LAN Signal].

❖ Transmission Speed
Specifies the communication speed of the IEEE 802.11b (wireless LAN).

• Auto

• 11Mbps Fixed

• 5.5Mbps Fixed

• 2Mbps Fixed

• 1Mbps Fixed

Note

❒ Default: Auto

❖ Return to Defaults
You can return the IEEE 802.11b (wireless LAN) settings to their defaults.

• No

• Yes
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Installing the Software

This manual assumes you are familiar with general Windows procedures and
practices. If you are not, see the operating instructions that come with Windows
for details.

The procedure for installing the printer driver depends on the connection with
the computer. With a parallel or Ethernet connection, Quick Install is also avail-
able. With a wireless LAN connection, check the printer and computer are com-
municating properly and then install the printer driver by following the
procedure used for an Ethernet connection.

• For details about the parallel/network connection, see p.26 “Quick Install” or
p.28 “Installing RPCS Printer Driver”.

• For details about the USB connection, see p.44 “Installing the Printer Driver
Using USB”.

Auto Run

Inserting the CD-ROM into the CD-ROM drive starts the installer automatically.
The installer helps you install the printer drivers and software easily.

Note

❒ If “plug and play” starts, click [Cancel] in [New Hardware Found], [Device Drive]
or [Found New Hardware Wizard] dialog box, and then insert the CD-ROM. The
[New Hardware Found], [Device Driver Wizard] or [Found New Hardware Wizard] dia-
log box appears depending on the system version of the Windows
95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0.

❒ Auto Run might not work automatically with certain operating system set-
tings. If this happens, launch "Setup.exe", located on the CD-ROM root direc-
tory.

❒ If you want to cancel Auto Run, hold down the {SHIFT} key (if your operating
system is Windows 2000/XP or Windows Server 2003, hold down the left
{SHIFT} key) while inserting the CD-ROM. Keep the {SHIFT} key held down
until the computer has finished accessing the CD-ROM.

Limitation

❒ If your operating system is Windows 2000/XP, Windows Server 2003, or
Windows NT 4.0, installing software using Auto Run requires Administrator
permission. When you install software using Auto Run, log on using an ac-
count that has Administrators permission.
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The following table shows the printer drivers and software that can be installed
using Auto Run:

*1 Available operating systems are: Windows 95/98/Me/2000/XP, Windows Server
2003, and Windows NT 4.0. Auto Run is unavailable with Macintosh.

Quick Install

Auto Run will start the installer automatically when you insert the CD-ROM
into the CD-ROM drive. By selecting Quick Install, you can easily install the
RPCS printer driver. SmartDeviceMonitor for Client can also be installed pro-
vided the printer and computer are connected via the network.

Preparation

Before starting installation, close all documents and applications.

Limitation

❒ The following conditions are required:

• Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0

For network connections:

• The printer must be connected to the network using an Ethernet cable.

• TCP/IP protocol must be configured.

• The IP address must be assigned to both printer and computer.

• The IEEE 802.11b interface unit is installed and the connection is properly
made.

For parallel connections:

• The printer must be connected to the computer using a parallel cable.

• Bidirectional transmission must be enabled.

Auto Run *1 

Quick Install Add Printer and 
Utility Wizard

Network connection 
with TCP/IP

Parallel connection

RPCS Printer Driver ❍ ❍ ❍

PostScript 3 Printer 
Driver

❍

SmartDeviceMonitor 
for Admin

❍

SmartDeviceMonitor 
for Client

❍ ❍
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Important

❒ If your system is Windows NT 4.0, we recommend that you upgrade the Win-
dows NT 4.0 operating system to Service Pack 4 or later before installing the
RPCS printer driver. Contact your Windows retailer for more information
about latest versions.

Note

❒ When the printer is connected to the computer using the USB interface, Quick
Install cannot be used. See p.44 “Installing the Printer Driver Using USB”.

A Quit all applications running.

B Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

C Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

D Click [Quick Install].

The software license agreement appears in the [License Agreement] dialog box.

E After reading through the agreement, click [I accept the agreement.] to agree,
and then click [Next].

F Click the printer model you are using when the [Select Printer] dialog box ap-
pears.

Note

❒ For TCP/IP network connection, select the printer whose IP address is dis-
played in the [Connect To] column.

❒ For parallel connection, select the printer whose printer port is displayed
in the [Connect To] column.

G Click [Install].
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H Follow the instructions on the screen.

A message prompting you to restart your computer may appear. To complete
installation, restart your computer.

Important

❒ If the printer has options installed, you should make settings for them us-
ing the printer driver. See p.33 “Setting Up Options - RPCS”.

Note

❒ If you want to change the printer name, follow the procedure below:

• Windows 95/98/Me/2000, and Windows NT 4.0
On the [Start] menu, point to [Settings], and then click [Printers]. The
[Printers] window appears. Right-click the printer icon, and then click
[Rename].

• Windows XP Professional and Windows Server 2003
On the [Start] menu, click [Printers and Faxes]. The [Printers and Faxes]
window appears. Right-click the printer icon, and then click [Rename].

• Windows XP Home Edition
On the [Start] menu, click[Control Panel]. Click [Printers and Other Hard-
ware], and then click [Printers and Faxes]. The [Printers and Faxes] window
appears. Right-click the printer icon, and then click [Rename].

Installing RPCS Printer Driver

This section gives basic instructions for installing the RPCS printer driver with-
out using Quick Install. Follow the procedures below, as appropriate.

Reference

See p.26 “Quick Install” to install the RPCS printer driver using Quick Install.

Limitation

❒ If your operating system is Windows 2000/XP, Windows Server 2003, or
Windows NT 4.0, installing a printer driver using Auto Run requires Admin-
istrator permission. When you install a printer driver using Auto Run, log on
using an account that has Administrator permission.

Important

❒ If your operating system is Windows NT 4.0, we recommend that you up-
grade the Windows NT 4.0 operating system to Service Pack 4 or later before
installing the printer drivers. Contact your Windows retailer for more infor-
mation about latest versions.
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Note

❒ If you want to share the printer on a Windows 2000/XP, Windows Server
2003, or Windows NT 4.0 platform, use the [Sharing] tab in the [Printer Proper-
ties] dialog box to specify the additional driver (alternate driver). For details,
see the operating instructions that come with Windows 2000/XP, Windows
Server 2003, or Windows NT 4.0.

❒ When prompted for the additional driver (alternate driver) location, select the
following folders on the CD-ROM:

• Windows 95/98/Me
RPCS: \DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1\

• Windows 2000/XP and Windows Server 2003
RPCS: \DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1\

• Windows NT 4.0
RPCS: \DRIVERS\RPCS\ NT4\(Language)\DISK1\

A Quit all applications running.

B Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

C Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

D Click [RPCS Printer Driver].

The software license agreement appears in the [License Agreement] dialog box.

E After reading through the agreement, click [I accept the agreement.] to agree,
and then click [Next].

F Select the printer drivers you want to install when the [Select Program] dia-
log box appears, and then click [Next].

G Select the model of the printer you are using.

To change the printer name, change it in the [Change settings for 'Printer Name']
box.

H Double-click the printer name to display the printer settings.
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I Select SmartDeviceMonitor.

SmartDeviceMonitor

A Click [Port:], and then click [Add].

B Click [SmartDeviceMonitor], and then click [OK].

C Select the printer you want to use.

❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available machines will be listed.

B Select the printer you want to use, and then click [OK].

Note

❒ Machines that respond to an IP broadcast from the computer will be
displayed. To print to a printer not listed here, click [Specify Address],
and then enter the IP address or host name.

❒ Part of the printer's IP address is used for the port name. Under Win-
dows 95/98/Me, avoid using an address that is partially similar to
one already in use. For example , if “192.168.0.2” is already used,
“192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is already
used, “192.168.0.2” cannot be used.

❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of machines that can be used with NetBEUI appears.

B Select the printer you want to use, and then click [OK].

Note

❒ NetBEUI cannot be used under Windows XP or Windows Server
2003.

❒ Machines that respond to a broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address],
and then enter the NetBEUI address. Confirm the NetBEUI address
on the network is on the configuration page. The NetBEUI address
appears as “\\RNPxxxx\xxx” on the configuration page. Enter the
machine's network path name in the form of "%%Computer
name\Share name". Do not enter "\\" but "%%" as head characters.

❒ You cannot print to machines beyond routers.
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❖ IPP

A Click [IPP].
The [IPP Setting] dialog box appears.

B To specify the IP address of the printer, enter "http://machine's-ip-
address/printer" or "ipp://machine's-ip-address/printer" in the
[Printer URL] box.
(Example: IP address is 192.168.15.16)

http://192.168.15.16/printer

ipp://192.168.15.16/printer

C If necessary, enter the names to distinguish the printer in the [IPP Port
Name] box. Enter a different name to those of any existing port name.
If you do not do this, the address entered in the [Printer URL] box will
be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings],
and then configure the necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor
for Client Help.

E Click [OK].

JMake sure the location for the selected printer appears after [Port:].

K Configure the user code and default printer as necessary.

❖ User Code
User codes are eight digit codes that allow you to keep track of printing done
under each code. To use this feature, the network administrator should assign
user codes and inform users of them before they install the printer driver.
Take the following procedures to enter a user code for registration:

• For the PostScript 3 printer driver, enter the user code on the [Job Log]
tab in the printer properties dialog box.

• For the RPCS printer driver, click the [Printer Configuration...] button on
the [Print Settings] tab in the [Printer Properties] dialog box. Click the [User
Code...] button. A dialog box appears. Enter the user code in the dialog
box.

Note

❒ When using the RPCS printer driver on Windows 95/98/Me, the user
code cannot be changed once it is entered. To change an entered user
code, uninstall the printer driver, reinstall it, and then enter a new user
code.

Reference

For more information about user codes, see Operating Instructions.

❖ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.
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L Click [Continue] to start printer driver installation.

M Follow the instructions on the screen.

Changing port settings

Follow these steps to change SmartDeviceMonitor for Client settings, such as the
proxy server settings or IPP URL.

Note

❒  There are no port settings for NetBEUI.

A In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

Note

❒ Under Windows XP and Windows Server 2003, click the icon of the printer
you want to use in the [Printers and Faxes] window.

B Click the [Details] tab, and then click [Port Settings].

The [Port Settings] dialog box appears.

Note

❒ Under Windows 2000/XP, Windows Server 2003, and Windows NT 4.0,
click the [Ports] tab, and then click [Configure Port...]. The [Port Configuration:]
dialog box appears.

• For TCP/IP, you can configure Timeout Settings.

Note

❒ If you cannot select the items on the [Recovery/Parallel Printing] tab, follow
the procedure below.

A Click [Cancel] to close the [Port Settings] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the Smart-
DeviceMonitor for Client icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Par-
allel Printing for each port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• For IPP, you can configure IPP User Settings, Proxy Settings and Timeout
Settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for
Client Help.
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Setting Up Options - RPCS

If the printer has options installed, you should set the options using the printer
driver.

Limitation

❒ Under Windows 2000/XP and Windows Server 2003, changing printer set-
tings requires Manage Printers permission. Members of the Administrators
and Power Users groups have Manage Printers permission by default. When
you set up options, log on using an account that has Manage Printers permis-
sion.

❒ Under Windows NT 4.0, changing printer settings requires Full Control per-
mission. Members of the Administrators, Server Operators, Print Operators,
and Power Users groups have Full Control permission by default. When you
set up options, log on using an account that has Full Control permission.

When setting up options, you should access the [Printer Properties] dialog box
from Windows. You cannot set up options by accessing the [Printer Properties] di-
alog box from an application.

RPCS printer driver

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note

❒ Under Windows XP Professional or Windows Server 2003, click the [Print-
ers and Faxes] window on the [Start] menu.

❒ Under Windows XP Home Edition, access the [Printers and Faxes] window
by clicking the[Start] button on the taskbar, click [Control Panel], click [Print-
ers and Other Hardware], and then click [ Printers and Faxes].

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

Note

❒ If the following message appears “Configure installed accessories in the
[Accessories] tab of [Printer Configuration...], which will open next.”, click
[OK], and then proceed to step E.

D Click the [Change Accessories...] tab.

Note

❒ Under Windows 95/98/Me, click [Printer Configuration...] on the [Print Set-
tings] tab, and then click [Change Accessories...].
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E Select the options installed in the [Select printer options:] list.

F Click [OK].

G Click [OK], and then close the [Printer Properties] dialog box.

Installing the PostScript 3 Printer Driver

This section gives basic instructions for installing the PostScript 3 printer driver.
Actual procedures may differ depending on the operating system. Follow the
procedures below, as appropriate.

Reference

To use the PostScript 3 printer driver, the PostScript board must be installed
on the printer. See PostScript3 for details.

Windows 95/98/Me - Installing the PostScript 3 printer driver

A Quit all applications running.

B Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

C Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed.

❒ When Russian is selected, an English version is installed.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Local Printer], and then click [Next].

A dialog box for selecting the printer appears.

G Select the model of the printer you are using, and then click [Next].

H In the [Available ports:] box, click [Printer Port], and then click [Next].
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I Change the name of the printer if you want to, and then click [Next].

Note

❒ Click [Yes] if you want to set the printer as the default printer.

J Follow the instructions on the screen.

Windows 95/98/Me - Setting up options

If the printer has options installed, you should make settings for them using the
printer driver.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

D Click the [Device Options] tab.

E Select the options you have installed in the [Installable options] area.

F Click [OK].

Windows 2000/XP and Windows Server 2003 - Installing the PostScript 3 printer driver

Limitation

❒ Installing a printer driver requires Administrator permission. When you in-
stall a printer driver, log on using an account that has Administrator permis-
sion.

Note

❒ If you want to share the printer on a Windows 2000/XP or Windows Server
2003 platform, use the [Sharing] tab in the [Printer Properties] dialog box to spec-
ify the additional driver (alternate driver). For details, see the operating in-
structions that come with Windows 2000/XP and Windows Server 2003.

❒ When prompted for the additional driver (alternate driver) location, select the
following folders on the CD-ROM:

• Windows 95/98/Me: \DRIVERS\PS\WIN9X_ME\(Language)\DISK1\

• Windows NT 4.0: \DRIVERS\PS\NT4\(Language)\DISK1\

A Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.
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C Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed.

❒ When Russian is selected, an English version is installed.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Click [Next].

F Click [Local Printer], and then click [Next].

Note

❒ Under Windows XP or Windows Server 2003, click [Local printer attached to
this computer], and then click [Next].

A dialog box for selecting the printer port appears.

G Select the check box of the port you want to use, and then click [Next].

A dialog box for selecting the printer appears.

H Select the model of the printer you are using, and then click [Next].

I Change the name of the printer if you want to, and then click [Next].

Note

❒ Click [Yes] if you want to set the printer as the default printer.

J Select whether or not you want to share the printer, and then click [Next].

Reference

See Network Guide for information about setting up and using the printer
in a network environment.

K Follow the instructions on the screen.
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Windows 2000/XP and Windows Server 2003 - Setting up options

If the printer has options installed, you should make settings for them using the
printer driver.

Limitation

❒ Changing the printer settings requires Manage Printers permission. Members
of the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note

❒ Under Windows XP Professional or Windows Server 2003, click the [Print-
ers and Faxes] window on the [Start] menu.

❒ Under Windows XP Home Edition, access the [Printers and Faxes] window
by clicking the [Start] button on the taskbar, click [Control Panel], [Printers
and Other Hardware], and then click [Printers and Faxes].

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The printer properties dialog box appears.

D Click the [Device Settings] tab.

E Select the options you have installed under [Installable Options].

F Click [OK].

Windows NT 4.0 - Installing the PostScript 3 printer driver

Limitation

❒ Installing a printer driver requires Administrator permission. When you in-
stall a printer driver, log on using an account that has Administrator permis-
sion.

Important

❒ The CD-ROM containing Windows NT Server operating system version 4.0,
or the Windows NT Workstation operating system is required to install the
printer driver.

❒ We recommend that you upgrade Windows NT 4.0 operating system to Serv-
ice Pack 6 or later before installing the printer driver. Contact your Windows
retailer for more information about latest versions.
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Note

❒ If you want to share the printer on a Windows NT 4.0 platform, use the [Shar-
ing] tab in the [Printer Properties] dialog box to specify the additional driver (al-
ternate driver). For details, see the operating instructions that come with
Windows NT 4.0.

❒ When prompted for the additional driver (alternate driver) location, select the
following folders on the CD-ROM:

• Windows 95/98/Me: \DRIVERS\PS\WIN9X_ME\(Language)\DISK1\

A Quit all applications running.

B Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

C Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed.

❒ When Russian is selected, an English version is installed.

D Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

E Confirm that the [My Computer] option is selected, and then click [Next].

A dialog box for selecting the printer port appears.

F Select the check box of the port you want to use, and then click [Next].

A dialog box for selecting the printer appears.

G Select the model of the printer you are using, and then click [Next].

H Change the name of the printer if you want to, and then click [Next].

Note

❒ Click [Yes] if you want to set the printer as the default printer.

I Select whether or not you want to share the printer, and then click [Next].

Reference

See Network Guide for information about setting up and using the printer
in a network environment.

J Follow the instructions on the screen.



Installing the Software

39

2

Windows NT 4.0 - Setting up options

If the printer has options installed, you should make settings for them using the
printer driver.

Limitation

❒ Changing printer settings requires Manage Printers permission. Members of
the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

D Click the [Device Settings] tab.

E Select the options you have installed under [Installable Options].

F Click [OK].

-Bidirectional transmission

When bidirectional transmission is enabled, information such as paper size and
feed orientation is automatically sent to the computer. You can also check print-
er status from your computer.

• Bidirectional transmission is supported under Windows 95/98/Me/2000/XP,
Windows Server 2003, and Windows NT 4.0.

• When bidirectional transmission is running, printer status and information
can be viewed by opening the printer driver screen.

To support bidirectional transmission, the following conditions are required:

❖ When connecting with USB 2.0

• The port on the USB 2.0 interface and the USB port on the computer are
connected using a USB interface cable (Windows 2000/XP, Windows Serv-
er 2003).

Note

❒ Under Windows 2000/XP or Windows Server 2003, [Enable bidirectional
support] must be selected, and [Enable printer pooling] must not be selected
on the [Ports] tab in RPCS printer driver.



Preparing to Print

40

2

❖ When connecting with the network

• The printer must be set to bidirectional transmission.

• SmartDeviceMonitor for Client included on the CD-ROM must be in-
stalled.

One of the following conditions must also be satisfied as well as the two re-
quirements mentioned above:

• The port for SmartDeviceMonitor and TCP/IP must be used.

• The standard TCP/IP port is used without changing the port name (Win-
dows 2000/XP, Windows Server 2003).

• The IP address specified in the Microsoft TCP/IP Print is used (Windows
NT 4.0).

• The IP address is included in port name, if using IPP protocol.

Note

❒ Under Windows 95/98/Me, [Enable bi-directional support for this printer] must
be selected in [Spool Settings] on the [Details] tab in RPCS printer driver.

❒ Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, [En-
able bidirectional support] must be selected, and [Enable printer pooling] must
not be selected on the [Ports] tab in RPCS printer driver.

❖ When connecting with a parallel cable

• The computer must support bidirectional transmission.

• The printer must be set to bidirectional transmission.

• The printer parallel port and computer parallel port are connected using a
parallel interface cable that supports bidirectional transmission.

Note

❒ Under Windows 95/98/Me, [Enable bi-directional support for this printer] must
be selected in [Spool Settings] on the [Details] tab in RPCS printer driver.

❒ Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, [En-
able bidirectional support] must be selected, and [Enable printer pooling] must
not be selected on the [Ports] tab in RPCS printer driver.
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Mac OS - Installing the PostScript 3 Printer Driver and Utilities

It is necessary to install a printer driver and a PPD file to print from a Macintosh.

Follow this procedure to install a printer driver and a PPD file on Macintosh run-
ning OS 8.6 or later versions up to 9.2, and Mac OS X Classic mode.

Note

❒ For installation under Mac OS X (v10.1.x), see p.43 “Mac OS X - Installing the
PostScript 3 Printer Driver”.

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM icon.

C Double-click the [Mac OS] folder.

D Double-click the [PS Driver] folder.

E Double-click the folder of the language you use.

F Open [Disk 1], and then double-click the installer icon.

The PostScript 3 printer driver installer window appears.

G Follow the instructions on the screen.

H Double-click [Extensions] in [System Folder].

I Double-click [Printer Descriptions].

J Double-click the CD-ROM icon on the desktop.

K Double-click the [Printer Descriptions] folder in the [Mac OS] folder.

L Double-click [Disk 1] in the folder of the language you use.

M Drag the PPD file into [Printer Descriptions] in [Extensions] in [System Folder].

N Restart the Macintosh.

Setting up the PPD file

Preparation

Make sure that the printer is connected to an AppleTalk network before per-
forming the following procedure:

A On the Apple menu, click [Chooser].

B Click the [Adobe PS] icon.

C In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.
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D Click [Setup].

E Click [Select PPD...].

F Click the printer description file you want to use, and then click [Select].

G Click [OK].

The PPD file is set up, and the [Adobe PS] icon appears at the left of the printer
name in the list. Next, follow the procedure on p.42 “Setting up options” to
make the option settings, or close the [Chooser] dialog box.

Setting up options

A On the Apple menu, click [Chooser].

B Click the [Adobe PS] icon.

C In the [Select a PostScript Printer:] list, click the name of the printer you want
to use, and then click [Setup...].

D Click [Configure].

A list of options appears.

E Select the option you want to set up, and then select the appropriate setting
for it.

Note

❒ If the option you want to set up is not displayed, the PPD file might not be
set up correctly. Check the name of the PPD file shown in the dialog box.

F Click [OK].

The list of options closes.

G Click [OK].

H Close the [Chooser] dialog box.
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Mac OS X - Installing the PostScript 3 Printer Driver

It is necessary to install a PPD file to print from a Macintosh. Follow the proce-
dures to install a PPD file on Macintosh running Mac OS X.

Printer driver is included in Mac OS. When printing under Mac OS X v10.1.x, use
the printer driver included in Mac OS.

Preparation

You need an administrator name and a password (phrase). For more informa-
tion, consult your administrator.

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM icon.

C Double-click the [Mac OS X] folder.

D Double-click the [Mac OSX PPD Installer] folder, and then double-click the in-
staller icon.

E Follow the instructions on screen.

Setting up the PPD file

A Run [Print Center].

B Click [Add Printer].

Note

❒ Select [AppleTalk] in the first pop-up menu.

❒ If the zone has been set, select the zone in the second pop-up menu.

C Select the PPD file for the model you are using from the [Printer Model:] pop-
up menu.

D Click [Add].

Selecting PPD files when using USB

It is necessary to select a PPD file in order to be able to use printers with USB con-
nection. Make the setting as described below.

A Run [Print Center].

B Click [Add Printer].

C Select [USB] in the first pop-up menu.
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D Select a printer and select the printer brand name of the printer in use from
the [Printer Model:] pop-up menu.

Note

❒ If using MAC OS X 10.1.x, a list of printer models is displayed on the[Printer
Model:] pop-up menu. Select the printer model in use and proceed to stepF.

E Select the connected printer model from the list of printers and Click [Add].

F Close the Printer List and close[Print Center].

Setting up options

Limitation

❒ You can make settings for all printer features, even if the necessary option is
not installed, due to Mac OS X Native mode limitations. Check which options
are installed in the printer before you print.

Installing the Printer Driver Using USB

This section gives basic instructions for installing printer drivers using USB. The
printer drivers can be installed from the CD-ROM that comes with this printer.

Preparation

Make sure that all other applications are closed and the computer is not print-
ing before installation.

Windows 98 SE/Me - Installing the printer driver using USB

Important

❒ Installation via USB is not possible under Windows 95/98. Upgrade to Win-
dows 98 SE/Me.

When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

A Turn off the power of the machine.

B Connect the machine with the computer via USB cable.

Connect the USB cable firmly.

C Turn on the power of the computer.

D Click [Next>].
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E Click [Search for the best driver for your device. {Recommended}.], and then click
[Next>].

F Select the [Specify a location:] check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

G Insert the CD-ROM into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

H Specify the location where USB Printing Support is located, and then click
[Next>].

If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:

D:\DRIVERS\USBPRINT\WIN98ME

I Check the location, and then click [Next].

USB Printing Support is installed.

J Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the "USB001" port is added to the [Printers]
window.

K Click [Next>].

L Click [Search for the best driver for your device. {Recommended}.], and then click
[Next>].

M Select the [Specify a location:], check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

N Insert the CD-ROM into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

O Specify the location where the source files of the printer driver is stored,
and then click [Next>].

• RPCS:\DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1

• PostScript 3:\DRIVERS\PS3\WIN9X_ME\(Language)\DISK1
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P Check the location, and then click [Next].

Add Printer Wizard starts.

Q Click [Finish].

Installation is complete. If installation is successful, the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

Note

❒ The number after "USB" varies depending on the number of printers con-
nected.

❒ It is not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

❒ After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.

Windows 2000/XP and Windows Server 2003 - Installing the printer driver using USB

Limitation

❒ Installing a printer driver requires the Administrators permission. When you
install a printer driver, log on using an account that has Administrator per-
mission.

When the USB interface cable is used for the first time, the [Found New Hardware
Wizard] dialog box appears, and Windows 2000/XP's USB Printing Support will
be installed automatically.

If the printer driver is already installed, the “plug and play” is displayed, and
the printer with its port directed to the USB interface cable is added to the [Print-
ers] *1  folder.

Note

❒ Under Windows XP, even if the printer driver has already been installed,
[Found New Hardware Wizard] may start when connecting the printer and the
computer with the USB interface cable for the first time. If this happens, in-
stall the printer driver by following the procedure below:

A Install the printer driver by referring to the instructions for installation.

Note

❒ Each printer driver is stored in the following folders on the CD-ROM:

• RPCS: \DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

• PostScript 3: \DRIVERS\PS\WIN2K_XP\(Language)\DISK1

When installation is complete, the printer with its port directed to “USB00n”
appears in the [Printers] *1  folder. (“n” is the number of printers connected.)
*1 Under Windows XP, the folder is [Printers and Faxes].
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Macintosh - Creating a desktop printer icon

When you connect the printer and your computer using USB 2.0, create a Desk-
top Printer icon.

Limitation

❒ Under Mac OS X Native mode, printing is disabled when connected to the
printer using USB.

A Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

B Select [AdobePS] in [With:] and [Printer (USB)] in [Create Desktop], and then
click [OK].

C Click [Change] in [USB Printer Selection].

D Select the model of the printer you are using in [Select a USB Printer:], and
then click [OK].

E Click [Auto Setup] in [PostScriptTM Printer Description (PPD) File].

F Click [Create].

G Enter the printer name, and then click [Save].

The printer icon appears on the desktop.

H Close the Desktop Printer Utility.

Installing SmartDeviceMonitor for Client/Admin

Limitation

❒ If your operating system is Windows 2000/XP, Windows Server 2003, or
Windows NT 4.0, installing software using Auto Run requires Administrator
permission. When you install a printer driver using Auto Run, log on using
an account that has Administrator permission.

A Quit all applications running.

B Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

C Select a language for the interface, and then click [OK].

The following languages are available: Deutsch (German), English (English),
Espanol (Spanish), Francais (French), Italiano (Italian), Nederlands (Dutch),
Russian (Russian)

The default interface language is English.

D Click [SmartDeviceMonitor for Client/Admin].

The software license agreement appears in the [License Agreement] dialog box.



Preparing to Print

48

2

E After reading through the agreement, click [I accept the agreement.] to agree,
and then click [Next].

F Select the program you want to install when the [Select Program] dialog box
appears.

G Follow the instructions on the screen.

Using Adobe PageMaker Version 6.0, 6.5, or 7.0

If you use the printer under Windows 95/98/Me/2000/XP, Windows Server
2003, or Windows NT 4.0 with Adobe PageMaker, you need to copy the PPD file
to the PageMaker folder. 

The PPD file is the file with the extension “.ppd” in the folder “DRIV-
ERS\PS\WIN9X_ME\(Language)\DISK1\” on the CD-ROM. 

The [WIN9X_ME] folder, inside the [PS] folder is for Windows 95/98/Me. Use the
folder at a level appropriate for the operating system you are currently using.

The third folder, “(Language)” may be renamed with an appropriate language
name.

Copy the file with extension “.ppd” to the PageMaker folder.

• For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4”.

• For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
“USENGLISH” may vary depending on your language selection.

• For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
“USENGLISH” may vary depending on your language selection.

Note

❒ When using PageMaker, optional features that can be selected by the printer
driver will not be active. The following procedure describes how to activate
the optional printer features.

A On the [File] menu, click [Print].
The [Print Document] dialog box appears.

B Make the necessary settings in the [Features] box.
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Software and Utilities Included on the CD-ROM

The CD-ROM labeled “Printer Drivers and Utilities” is mainly used for printer
printer functions. In this manual, “CD-ROM” refers to the “Printer Drivers and
Utilities” CD-ROM, unless specified otherwise.

Printer Drivers

Printing requires installation of a printer driver for your operating system. The
following drivers are included on the CD-ROM labeled “Printer Drivers and
Utilities” that comes with the printer option of this printer.

*1 Microsoft Windows 95 operating system
*2 Microsoft Windows 98 operating system
*3 Microsoft Windows Millennium Edition
*4 Microsoft Windows 2000 Server

Microsoft Windows 2000 Professional
*5 Microsoft Windows XP Professional

Microsoft Windows XP Home Edition
*6 Microsoft Windows Server 2003 Standard Edition

Microsoft Windows Server 2003 Enterprise Edition
Microsoft Windows Server 2003 Web Edition

*7 Cluster and Terminal Service are not supported.
*8 Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT

Workstation operating system version 4.0 in a computer using x86 processors.
*9 Versions 8.6 to 9.2 of the Mac OS (Mac OS X Classic mode is supported.)
*10 Mac OS X 10.1 or later (Native mode)
*11 Requires Service Pack 4 or later.
*12 Requires Service Pack 6 or later.
*13 The Adobe PostScript 3 printer drivers and PostScript Printer Description (PPD) files

are included on the CD-ROM labeled “Printer Drivers and Utilities”.
*14 The PostScript Printer Description (PPD) files are included on the CD-ROM labeled

“Printer Drivers and Utilities”.
*15 The Adobe PostScript Printer Description (PPD) installer is included on the CD-

ROM labeled “Printer Drivers and Utilities”.

Printer Language RPCS PostScript 3

Windows 95 *1 √ √ *13 

Windows 98 *2 √ √ *13 

Windows Me *3 √ √ *13 

Windows 2000 *4 √ √ *14 

Windows XP *5 √ √ *14 

Windows Server 2003 *6 √ *7 √ *7  *14 

Windows NT 4.0 *8 √ *11 √ *12  *13 

Mac OS *9 √ *13 

Mac OS X *10 √ *15 
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❖ RPCS printer driver
The RPCS printer drivers are included on the CD-ROM labeled "Printer Driv-
ers and Utilities" This printer driver allows the computer to communicate
with the printer via a printer language. The preset type user interface is pro-
vided in addition to the usual one.
See p.28 “Installing RPCS Printer Driver” .

❖ Adobe PostScript 3 printer drivers and PPD files
The Adobe PostScript 3 printer drivers and the PPD files are included on the
CD-ROM labeled "Printer Drivers and Utilities" This printer driver allows the
computer to communicate with the printer via a printer language. The PPD
files allow the printer driver to enable printer specific functions.
See p.34 “Installing the PostScript 3 Printer Driver” .

Software and Utilities

❖ SmartDeviceMonitor for Admin
This utility is for the system administrator to manage network printers.

Reference

For more information about using SmartDeviceMonitor for Admin, see
SmartDeviceMonitor for Admin online Help.

❖ SmartDeviceMonitor for Client
This utility is for users to manage their own print status on the network.

Reference

For more information about using SmartDeviceMonitor for Client, see
SmartDeviceMonitor for Client online Help.

❖ Acrobat Reader
This utility allows you to read PDF (Portable Document Format) files.

Note

❒ Documentation about using the printer is included on the CD-ROM in PDF
format. For more information about using Acrobat Reader, see Acrobat
Reader online Help.

❖ Printer Utility for Mac
This utility allows users to download and manage a variety of fonts as well as
manage printers. For more information about this utility, see PostScript3
which is provided as a PDF file on the CD-ROM labeled “Operating Instruc-
tions”.

Important

❒ Software and utilities must be uninstalled before installing newer versions of
Windows. Reinstall software and utilities after upgrading Windows.
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3. Setting Up the Printer Driver
and Canceling a Print Job

Accessing Printer Properties

Windows 95/98/Me - Accessing Printer Properties

Changing default settings

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer whose default you want to change.

C On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DMake the settings you require, and then click [OK].

Note

❒ With some applications, printer driver settings are not used, and the appli-
cation's own settings are applied.

Making settings from an application

To make settings for a specific application, open the printer properties dialog
box from that application. The following example describes how to make set-
tings for the WordPad application that comes with Windows 95/98/Me.

Note

❒ Actual procedures for opening the [Printer Properties] dialog box may vary de-
pending on the application. For more information, see the operating instruc-
tions that come with the application you are using.

❒ Any setting you make in the following procedure is valid for the current ap-
plication only:

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B In the [Name] list, select the printer you want to use, and then click [Proper-
ties...].

The [Printer Properties] dialog box appears.

CMake the settings you require, and then click [OK].

D Click [OK] to start printing.
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Windows 2000/XP and Windows Server 2003 - Accessing Printer 
Properties

Changing default settings - Printer properties

Limitation

❒ Changing printer settings requires Manage Printers permission. Members of
Administrators and Power Users groups have Manage Printers permission
by default. When you set up options, log on using an account that has Manage
Printers permission.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note

❒ Under Windows XP Professional and Windows Server 2003, open the
[Printers and Faxes] window on the [Start] menu.

❒ Under Windows XP Home Edition, open the [Printers and Faxes] window
by clicking [Control Panel] from the [Start] button on the taskbar, click [Print-
ers and Other Hardware], and then click [Printers and Faxes].

B Click the icon of the printer whose default you want to change.

C On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DMake the settings you require, and then click [OK].

Note

❒ Normally you do not have to change the “Form to Tray Assignment” set-
tings on the [Device Settings] tab in the PostScript 3 printer driver.

❒ Settings you make here are used as default for all applications.
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Changing default settings - Printing preferences properties

Limitation

❒ Changing printer settings requires Manage Printers permission. Members of
the Administrators and Power Users groups have Manage Printers permis-
sion by default. When you set up options, log on using an account that has
Manage Printers permission.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

Note

❒ Under Windows XP Professional and Windows Server 2003, open the
[Printers and Faxes] window on the [Start] menu.

❒ Under Windows XP Home Edition, open the [Printers and Faxes] window
by clicking [Control Panel] from the [Start] button on the taskbar, click [Print-
ers and Other Hardware], and then click [Printers and Faxes].

B Click the icon of the printer whose default you want to change.

C On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DMake the settings you require, and then click [OK].

Note

❒ Settings you make here are used as default for all applications.

Making settings from an application

To make settings for a specific application, open the [Print] dialog box from that
application. The following example describes how to make settings for the
WordPad application that comes with Windows 2000/XP and Windows Server
2003.

Note

❒ Actual procedures for opening the [Print] dialog box vary depending on the
application. For more information, see the operating instructions that come
with the application you are using.

❒ Any setting you make in the following procedure is valid for the current ap-
plication only.
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A On the [File] menu, click [Print...].

The [Print] dialog box appears.

B In the [Select Printer] list, select the printer you want to use, and then click
the tab for which you want to change print settings.

Note

❒ Under Windows XP and Windows Server 2003, click [Preferences] to open
the [Printing Preferences] dialog box.

CMake the settings you require.

D Click [Print] to start printing.

Under Windows XP and Windows Server 2003, click [OK], and then click
[Print] to start printing.

Windows NT 4.0 - Accessing Printer Properties

Changing default settings - Printer properties

Limitation

❒ Changing printer settings requires Full Control access permission. Members
of Administrators, Server Operators, Print Operators, and Power Users
groups have Full Control permission by default. When you set up options, log
on using an account that has Full Control permission.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer whose default you want to change.

C On the [File] menu, click [Properties].

The [Printer Properties] dialog box appears.

DMake the settings you require, and then click [OK].

Note

❒ Normally you do not have to change the “Form to Tray Assignment” set-
tings on the [Device Settings] tab in the PostScript 3 printer driver.

❒ Settings you make here are used as default for all applications.
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Changing the default settings - Default document properties

Limitation

❒ Changing printer settings requires Full Control access permission. Members
of the Administrators, Server Operators, Print Operators, and Power Users
groups have Full Control permission by default. When you set up options, log
on using an account that has Full Control permission.

A On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer whose default you want to change.

C On the [File] menu, click [Document Defaults...].

The [Default] dialog box appears.

DMake the settings you require, and then click [OK].

Note

❒ Settings you make here are used as default for all applications.

Making settings from an application

To make settings for a specific application, open the [Printer Properties] dialog box
from that application. The following example describes how to make settings for
the WordPad application that come with Windows NT 4.0.

Note

❒ Actual procedures for opening the [Printer Properties] dialog box vary depend-
ing on the application. For more information, see the operating instructions
that come with the application you are using.

❒ Any setting you make in the following procedure is valid for the current ap-
plication only.

A On the [File] menu, click [Print].

The [Print] dialog box appears.

B In the [Name] list, select the printer you want to use, and then click [Proper-
ties].

The [Printer Properties] dialog box appears.

CMake the settings you require, and then click [OK].

D Click [OK] to start printing.
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Macintosh - Setting Up for Printing

Making paper settings from an application

A Open the file you want to print.

B On the [File] menu, click [Page Setup...].

The [AdobePS Page Setup] dialog box appears.

CMake sure the printer you want to use is shown in the [Printer:] box.

Note

❒ Under Mac OS X, this is called [Format for:].

❒ If the printer is not shown in the [Printer:] box, use the pop-up menu to dis-
play a list of available machines.

Reference

The actual appearance of Page Setup depends on the application you are
using. See the operating instructions that come with the Macintosh for
more information.

D In the [Paper:] box, select the paper size.

Note

❒ Under Mac OS X, this is called [Paper Size:].

EMake the settings you require, and then click [OK].

Setting up for printing from an application

A Open the file you want to print.

B On the [File] menu, click [Print:].

The [Printer Features] dialog box appears.

CMake sure the printer is selected in the [Printer:] box.

DMake the settings you require, and then click [Print] to start printing.
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Canceling a Print Job

Canceling from a computer

Windows

A Double-click the printer icon on the Windows taskbar.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

B Select the name of the job you want to cancel.

C On the [Document] menu, click [Cancel Printing].

Note

❒ You can also open the print job queue window by double-clicking the
printer icon in the [Printer] window.

Macintosh

A Double-click the printer icon on the desktop.

A window appears, showing all the print jobs that are currently queuing to
be printed. Check the current status of the job you want to cancel.

Note

❒ Under Mac OS Χ, start Print Center. 

B Select the name of the job you want to cancel.

C Click the pause icon, and then click the trash icon.

Note

❒ Under Mac OS Χ, Click [Hold], and then click [Delete].
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Canceling on the control panel

Canceling before the printer starts Master Making

The print jobs of all pages can be canceled before the printer starts Master Mak-
ing.

A Press [Job Reset] on the machine's display panel.

Canceling after the printer has started Master Making

In order to cancel the print job after Master Making has started, press “Job Reset”
or “End Printing” on the display panel.

❖ Pressing “Job Reset” while Master Making is in progress
If “Job Reset” is pressed while Master Making is processing a particular page,
the print job will be cancelled beginning from the next page.

Note

❒ If the Master Making is processing the last page of a print job, the print job
cannot be canceled

❖ Pressing “Job Reset” while printing
If “Job Reset” is pressed while printing job is processing a particular page, the
job will be canceled beginning from the next page.

Note

❒ If the print job is processing the last page of job, the next print job will be
canceled. If there are no print jobs in queue, the “Job Reset” button will not
function.

❖ Pressing “End Printing” while printing queue is on pause
When a print job is on pause, the next Master Making cannot begin until the
print job has been completed. If there is a page after the spot the printing was
paused, press the “End Printing” then the printer will cancel the paused page
and the Master Making of the next page will begin.
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4. Various Types of Printing

Windows 95/98/Me - Various Types of Printing

This section introduces several printing examples from Windows 95/98 and Me.

Reference

As printing can vary depending on the application, see the respective docu-
mentation that comes with the application regarding details on settings.

Printing on custom sized paper

Printing on custom sized paper

Important

❒ Be sure to load paper in the paper feed tray.

A Display the data to be printed.

B On the [File] menu, click [Print...].

The [Print] dialog box appears.

C From [Name:], select the printer.

D Click [Properties].

The [Properties] dialog box appears.

E In the [Original size:] menu on the [Print Settings] tab, click [Custom paper size...].

The [Custom Paper Sizes] dialog box appears.

F Enter the paper size in [Short edge:] and [Long edge:].

Note

❒ Specify [Measurement Unit...] if required.

G Select [Place as portrait] or [Place as landscape] according to the paper orienta-
tion.

H Click [OK].

The screen returns to the [Properties] dialog box.

I Click [OK].

The screen returns to the [Print] dialog box.

J Click [OK].
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Printing on paper with an undetectable size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size depending on the paper size. In these
cases, follow the procedure below and manually make the desired settings.

Important

❒ Be sure to load paper in the paper feed tray.

Note

❒ If you make these settings frequently, it is convenient to define a default size
by selecting [Tray Paper Size: Paper Feed Tray] in Online Print menu on the con-
trol panel.

A Press the {Printer Settings}key on the printer.

B Press [Tray Paper Size: Paper Feed Tray].

C Select the paper size, and then press [OK].

Important

❒ Select a size that is bigger than the contents to be printed. If the contents
are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

D Select the paper size on the computer's printer driver.

Important

❒ Select the same paper size selected in the [Tray Paper Size: Paper Feed Tray]
setting on the machine.

E Print from the computer.

AJK136S
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When envelopes cannot be fed

Envelopes cannot be fed in well because the seal may get caught. In that case,
you can rotate and print the image by 180 degrees using the rotate function in
the printer driver.

The following chart shows how the image is rotated.

Paper Feed 
Direction

Original Image Rotate: Off Rotate: 180°

Short Edge 
Feed

Portrait

Landscape

Long Edge Feed

Portrait

Landscape
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A Rotate the envelopes 180 degrees and place them in the paper feed tray.

B On the printer driver’s [Misc.] tab, select [Rotate by 180 degrees].

C Click [OK].

The screen returns to the [Print] dialog box.

D Click [OK] to start printing.

GRENVE1E
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Windows 2000/XP and Windows Server 
2003 - Various Types of Printing

This section introduces several printing examples from Windows 2000/XP and
Windows Server 2003.

Reference

As printing can vary depending on the application, see the respective docu-
mentation that comes with the application regarding details on settings.

Printing on custom sized paper

It is possible to make settings for custom sized paper.

Important

❒ Be sure to load paper in the paper feed tray.

A Display the data to be printed.

B On the [File] menu, click [Print...].

The [Print] dialog box appears.

C From [Select Printer], select the printer.

D Click [Properties].

The [Properties] dialog box appears.

E In the [Original size:] menu on the [Print Settings] tab, click [Custom paper size...].

The [Custom Paper Sizes] dialog box appears.

F Enter the paper size in [Short edge:] and [Long edge:].

Note

❒ Specify [Measurement Unit...] if required.

G Select [Place as portrait] or [Place as landscape] according to the paper orienta-
tion.

H Click [OK].

The screen returns to the [Properties] dialog box appears.

I Click [OK].

The screen returns to the [Print] dialog box.

J Click [Print].
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Printing on paper with an undetectable size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size depending on the paper size. In these
cases, follow the procedure below and manually make the desired settings.

Important

❒ Be sure to load paper in the paper feed tray.

Note

❒ If you make these settings frequently, it is convenient to define a default size
by selecting [Tray Paper Size: Paper Feed Tray] in the Online Print menu on the
control panel.

A Press the {Printer Settings}key on the printer.

B Press [Tray Paper Size: Paper Feed Tray].

C Select the paper size, and then press [OK].

Important

❒ Select a size that is bigger than the contents to be printed. If the contents
are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

D Select the paper size on the computer's printer driver.

Important

❒ Select the same paper size selected in the [Tray Paper Size: Paper Feed Tray]
setting on the machine.

E Print from the computer.

AJK136S
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When envelopes cannot be fed

Envelopes cannot be fed in well because the seal may get caught. In that case,
you can rotate and print the image by 180 degrees using the rotate function in
the printer driver. The following chart shows how the image is rotated.

Paper Feed 
Direction

Original Image Rotate: Off Rotate: 180°

Short Edge 
Feed

Portrait

Landscape

Long Edge Feed

Portrait

Landscape
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A Rotate the envelopes 180 degrees and place them in the paper feed tray.

B On the printer driver’s [Misc.] tab, select [Rotate by 180 degrees].

C Click [OK].

The screen returns to the [Print] dialog box.

D Click [Print] to start printing.

GRENVE1E
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Windows NT 4.0 - Various Types of Printing

This section introduces several printing examples from Windows NT 4.0.

Reference

As printing can vary depending on the application, see the respective docu-
mentation that comes with the application regarding details on settings.

Printing on custom sized paper

It is possible to make settings for custom sized paper.

Important

❒ Be sure to load paper in the paper feed tray.

A Display the data to be printed.

B On the [File] menu, click [Print...].

The [Print] dialog box appears.

C From [Name:], select the printer.

D Click [Properties].

The [Properties] dialog box appears.

E In the [Original size:] menu on the [Print Settings] tab, click [Custom paper size...].

The [Custom Paper Sizes] dialog box appears.

F Enter the paper size in [Long edge:] and [Short edge:].

Note

❒ Specify [Measurement Unit...] if required.

G Select [Place as portrait] or [Place as landscape] according to the paper orienta-
tion.

H Click [OK].

The screen returns to the [Properties] dialog box.

I Click [OK].

The screen returns to the [Print] dialog box.

J Click [OK].
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Printing on paper with an undetectable size

This machine automatically detects the paper size, however, there are cases
where the machine cannot detect the size depending on the paper size. In these
cases, follow the procedure below and manually make the desired settings.

Important

❒ Be sure to load paper in the paper feed tray.

Note

❒ If you make these settings frequently, it is convenient to define a default size
by selecting [Tray Paper Size: Paper Feed Tray] in the Online Print menu on the
control panel.

A Press the {Printer Settings}key on the printer.

B Press [Tray Paper Size: Paper Feed Tray].

C Select the paper size, and then press [OK].

Important

❒ Select a size that is bigger than the contents to be printed. If the contents
are bigger than the size selected and the data is printed, it will, for example,
cause the roller to get dirty.

D Select the paper size on the computer's printer driver.

Important

❒ Select the same paper size selected in the [Tray Paper Size: Paper Feed Tray]
setting on the machine.

E Print from the computer.

AJK136S
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When envelopes cannot be fed

Envelopes cannot be fed in well because the seal may get caught. In that case,
you can rotate and print the image by 180 degrees using the rotate function in
the printer driver.

The following chart shows how the image is rotated.

Paper Feed 
Direction

Original Image Rotate: Off Rotate: 180°

Short Edge 
Feed

Portrait

Landscape

Long Edge Feed

Portrait

Landscape
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A Rotate the envelopes 180 degrees and place them in the paper feed tray.

B Click [Add/Change Custom Settings...] on the printer driver’s [Print Settings] tab.

C On the printer driver’s [Misc.] tab, select [Rotate by 180 degrees].

D Click [OK].

The screen returns to the [Print] dialog box.

E Click [OK] to start printing.

GRENVE1E
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5. Troubleshooting

Error & Status Messages on the Display Panel

Messages/Second messages Descriptions and Solutions

Ethernet board Error. An error has occurred in the Ethernet module.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Wireless card error. IEEE 802.11b card was not inserted when the printer was turned 
on, or it was pulled out after the printer turned on.

Turn off the printer and check the IEEE 802.11b card is inserted 
correctly. Then, turn the printer on again. If the message ap-
pears again, contact your sales or service representative.

Wireless board error. An error has occurred in the IEEE 802.11b module.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Master Processing... The master is being made.

Memory switch error. An error has occurred in the memory unit.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Optional RAM error. An error has occurred in the SDRAM module.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Printing... Data is being printed.

Wait until the job is finished.

Parallel I/F board error. An error has occurred in the parallel I/F board.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

DIMM value error error. An error has occurred in the PostScript3 module.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

HDD board error. An error has occurred in the HDD boar.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Print is not finished. Printing is not finished.

Printing has been interrupted. Perform one of the following 
procedures:

• Press the {Print} key, and printing will restart. Before the 
print amount display reaches 0, press the {Print} key to print.

• Press [End Printing] , and printing will stop. The interrupted 
prints will not be performed.
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Ready<Online> The Master Making or print data is not in the spool.

This is not an error. The message will change when printing 
starts from the computer.

Ready

Resetting Job... The data spooled is dumped.

Wait until the job is finished.

Open the Paper Feed Tray. The paper feed tray is not set correctly.

Set the paper feed tray correctly.

USB interface error. An error has occurred in the USB interface.

Turn off the main power switch, and back on again. If the mes-
sage appears again, contact your sales or service representative.

Waiting... Waiting for data from the computer.

Wait until the job is finished.

Messages/Second messages Descriptions and Solutions
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Printer does not Print

Possible Cause Solutions

Is the power on? Turn on the printer.

Does the Printer key stay 
red?

If so, check the error message or warning status on the display and 
take the required action.

Are there any error messag-
es on the display panel? 

Check the error message, and take the required action.

Is the interface cable prop-
erly connected?

Connect the interface cable properly.

If there are any connectors or screws, make sure that they are fas-
tened securely.

Are you using the correct 
interface cable?

Be sure to use the correct one. If the cable is damaged or worn, re-
place it with a new one.

Did you connect the inter-
face cable after turning on 
the main switch?

Be sure to connect the interface cable before turning on the main 
switch.

Is the specified paper set? Set the specified paper in the paper feed tray.

Does the Error indicator 
stay red?

Check the error message, and take the required action.

Is the Data In indicator 
blinking or lit?

If it is not, the data does not reach the printer. Check the printer 
cable connection. Also confirm that the printer port settings are 
correct.

Can you make a proof 
print?

If you cannot print a system configuration list or a PS Font List 
from the printer, the printer might be out of order. Contact your 
sales or service representative.

Is “Waiting” displayed? Perform one of the following procedures:

• Wait until the job is finished.

• Cancel by pressing [Job Reset].

Is the signal status satisfac-
tory when using IEEE 
802.11b interface unit in in-
frastructure mode?

To check signal status, press the {UserTools} key, and then select 
[System Settings]. On the [Interface Settings], select [IEEE 802.11b], 
and then select [Wireless LAN Signal] . If signal quality is poor, re-
move objects that might cause interference.

Note

❒ You can check signal status only when using IEEE 802.11b in-
terface unit in infrastructure mode.

When using IEEE 802.11b 
interface unit, is the SSID 
correctly set?

Check using the machine's control panel that the SSID is correctly 
set.

see “User Tools Menu (System Settings)”, Network Guide.

When using IEEE 802.11b 
interface unit, is the access 
point correctly set?

Check access point settings when in infrastructure mode. Depend-
ing on the access point, client access may be limited by MAC ad-
dress.

Also, check there are no problems in transmission between access 
point and wired clients, and between access point and wireless cli-
ents.
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If you cannot solve the problem by taking the preceding actions, contact your
sales or service representative.

Note

❒ If the Data In indicator is not blinking or lit, you can check the computer port
settings using the following procedure.

❖ If the printer is connected to the computer using the interface cable
❒ Check that the printer port setting is correct. For USB, specify USB00(n)
as the printer port setting ( “n” is the number of printers on the network).
❒ For a parallel port connection, port LPT1 or LPT2 should be set.

• Windows 95/98/Me

A Click the [Start] button, point to [Settings], and then click [Printers].

B Click the icon of the printer. On the [File] menu, click [Properties].

C Click the [Details] tab.

D In the [Print to the following port:] list, confirm the correct port is selected.

• Windows 2000

A Click the [Start] button, point to [Settings], and then click [Printers].

B Click the icon of the printer. On the [File] menu, click [Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct port is selected.

• Windows XP Professional and Windows Server 2003

A Click the [Start] button, and then click [Printers and Faxes].

B Click the icon of the printer. On the [File] menu, click [Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct port is se-
lected.

• Windows XP Home Edition

A Click the [Start] button, click [Control Panel], click [Printers and Other
Hardware], and then click [Printers and Faxes].

B Click the icon of the printer. On the [File] menu, click [Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct port is selected.

When using IEEE 802.11b 
interface unit, is the LED 
on the wireless LAN card 
blinking or lit?

Confirm the orange LED is lit, and the green LED is blinks or lit 
during transmission.

Is the IEEE 802.11b inter-
face being used in ad hoc 
mode?

Turn the main power off and back on. See “Turning On the Pow-
er”, General Settings Guide.

Otherwise, configure [Network] in [Interface Settings] in [System Set-

tings]. See “Setting Up the Machine on a Network”, Network Guide.

Possible Cause Solutions
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• Windows NT 4.0

A Click the [Start] button, point to [Settings], and then click [Printers].

B Click the icon of the printer. On the [File] menu, click [Properties].

C Click the [Ports] tab.

D In the [Print to the following port(s)] list, confirm the correct port is se-
lected.

❖ Network Connection
❒ Contact your network administrator.
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Other Printing Problems

Status Possible Causes, Descriptions, and Solutions

Multiple pages are fed through 
the printer at once.

Remove all paper from the paper feed tray and fan it gently 
to get air between the sheets. After that, load it back into the 
paper feed tray.

The image is printed on the re-
verse side of the paper.

Load the paper the other way up.

Paper misfeeds occur frequently. Use the recommended paper. Avoid using curled, folded, 
wrinkled, perforated or glossy paper.

The display panel error message 
stays on after removing the mis-
fed paper.

Open the front cover of the printer and then close it.

A print instruction was issued 
from the computer, but printing 
did not start.

User code management may have been set. Ask the adminis-
trator about valid user codes. To print, the user code must be 
entered from the printer driver.

Photo images are coarse. Some applications reduce print resolution.

Images are cut off, or excess is 
printed.

You may be using paper smaller than the size selected in the 
application. Use the same size paper as that selected in the 
application. If you cannot load paper of the correct size, use 
the reduction function to reduce the image, and then print.

See the printer driver Help.

Page layout is not as expected. Print areas differ depending on printer used. Information 
that fits on a single page on one printer may not fit on a single 
page of another printer.

Adjust the [Printable area:] setting on the [Printer Configura-

tion...] tab in the RPCS printer driver.

See the printer driver Help.
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It takes a long time to complete 
a print job.

Photographs and other data intensive pages take a long time 
for the printer to process, so simply wait when printing such 
data.

Changing the following settings with the printer driver may 
help speed up printing:

• RPCS
Click [Change User Settings...] on the [Print Quality] tab in the 
[Printer Properties] dialog box, and then select the [Fast] 
value for [Image processing priority:] on the [Image Adjust-

ments] tab in the [Change User Settings...] dialog box.

Note

❒ Under Windows 2000/XP and Windows Server 2003, 
click [Change User Settings...] on the [Print Quality] tab in 
the [Printing Preferences] dialog box, and then select the 
[Fast] value for [Image processing priority:] on the [Image 

Adjustments] tab in the [Change User Settings...] dialog 
box.

❒ Under Windows NT 4.0, click [Change User Settings...] 
on the [Print Quality] tab in the [Document Defaults] dia-
log box, and then select the [Fast] value for [Image 

processing priority:]on the [Image Adjustments] tab in the 
[Change User Settings...] dialog box.

• PostScript 3
Select [PostScript (optimize for speed)]for [PostScript output 

format:] on the [PostScript] tab in the [Printer Properties] di-
alog box.

Note

❒ Under Windows 2000/XP and Windows Server 2003, 
click [Advanced...] on the [Paper/Quality] tab in the [Print-

ing Preferences] dialog box, and then select [PostScript 

output options : optimize for speed] for [PostScript Options] 
in the [Advanced...] dialog box.

❒ Under Windows NT 4.0, click [Advanced...] in the [Doc-

ument Defaults] dialog box, and then select [PostScript 

output options : optimize for speed] for [PostScript Options] 
in the [Advanced...] dialog box.

See the printer driver Help.

The data is so large or complex that it takes time to process. 
If the Data In indicator is blinking, data is being processed. 
Simply wait until printing resumes.

It takes too much time to resume 
printing.

The data is so large or complex that it takes time to process. 
If the Data In indicator is blinking, data is being processed. 
Simply wait until printing resumes.

The printer was in Energy Saver mode. To resume from En-
ergy Saver mode, it has to wake up, and this takes time. See 
Operating Instructions.

Status Possible Causes, Descriptions, and Solutions
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Images are printed in the wrong 
orientation.

The feed orientation you selected and the feed orientation se-
lected in the printer driver's option setup might not be the 
same. Set the machine's feed orientation and the printer driv-
er's feed orientation accordingly.

See the printer driver Help.

<Only when using PostScript 3 
under Windows>

The data which uses propor-
tional fonts cannot be printed 
exactly as viewed on the screen.

• Under Windows 95/98/Me
Select [Substitute printer fonts for True Type Fonts when appli-

cable] in the [Fonts] tab.

• Under Windows 2000/XP and Windows Server 2003
Click [Advanced...] on the [Paper/Quality] tab or on the [Lay-

out] tab to display the [Advanced Options] dialog box. Select 
[Download as softfont] in [TrueType Font:] in [Graphic].

• Under Windows NT 4.0
Click the [Advanced] tab on the [Properties] dialog box. Se-
lect [Download as softfont] in [TrueType Font] in [Graphics] .

<Only when using PostScript 3 
under Windows>

Combine printing cannot be 
done as specified.

Make sure that the same orientation is set, as well as the same 
paper size set in the application.

• Under Windows 95/98/Me, check the [Paper] tab.

• Under Windows 2000/XP and Windows Server 2003, 
check the [Layout] tab.

• Under Windows NT 4.0, check the [Page Setup] tab.

If a different size has been set, select the correct paper size 
and orientation.

<Only when using PostScript 3 
under Windows>

Auto Magnification cannot be 
done as specified.

<Only when using PostScript 3 
under Windows>

Printing cannot be done even if 
the data is being received in a 
network environment.

• Windows 95/98/Me
Click [Advanced...] on the [PostScript] tab to display the 
[Advanced PostScript Options] dialog box. Make sure to 
clear both the [Send CTRL+D after job] check box and the 
[Send CTRL+D before job] check box.

• Windows 2000/XP and Windows Server 2003
Make sure to select [No] in both [Send CTRL-D Before Each 

Job:] and [Send CTRL-D After Each Job:] in the [Device Set-

tings] tab.

• Windows NT 4.0
Make sure to select [No] in both [Send CTRL+D Before Each 

Job] and [Send CTRL+D After Each Job] in the [Device Set-

tings] tab.

<Mac OS only>

The printer is not displayed in 
the Chooser.

Make sure that the printer and the Macintosh are connected 
in the Appletalk environment.

<Mac OS Χ only>

The printer is not displayed in 
the Printer list.

<Macintosh only>

It takes a long time for the [Print] 
dialog box to be displayed.

Depending on the processing speed of the Macintosh system, 
the dialog box display may take time.

Status Possible Causes, Descriptions, and Solutions
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<Macintosh only>

It takes a long time to print from 
the Macintosh G3 or G4 via a hub.

When the printer is connected to a Macintosh computer 
equipped with the G3 or G4 processor via a hub, it may take 
a long time to transfer data on a 100BASE-TX from the Mac-
intosh to the printer.

The same page is being master 
made many times.

Make sure to clear the [Collate] check box in the [Print] dialog 
box of the application.

< Windows 2000/XP and Windows Server 2003 only >

Even if the check mark is cleared in the [Collated] check box, 
master making may be done everytime a page is going to be 
printed. In this case, make sure to clear the [collated] check 
box displayed when selecting [Copy Count] in [Advanced] dia-
log box of the printer driver.

Fine dot patterns are not printed • RPCS
Change the [Dithering:] setting under the [Image Adjust-

ments] tab in the [Change User Settings] dialog box under 
the [Print Quality] tab in the [Printer Properties] dialog box.

• PostScript 3
Change the [Dithering:] setting in the [Advanced] dialog box 
under the printer driver's [Print Quality] tab.

Solid lines are printed as broken 
lines.

In the RPCS printer driver [Change User Settings] dialog box, 
change the [Dithering:] setting on the [Image Adjustments] tab.

For details, see the printer driver Help.

Two or more sheets are fed to-
gether.

In the RPCS printer driver [Change User Settings] dialog box, 
change the [Dithering:] setting on the [Image Adjustments] tab.

For details, see the printer driver Help.

The set option cannot be select-
ed in the print menu.

The option may not be set correctly.

• Windows95/98/Me
Set the option correctly in the [Device Options] tab.

• Windows 2000/XP and Windows Server 2003
Set the option correctly in the [Device Settings] tab.

• Windows NT 4.0
Set the option correctly in the [Device Settings] tab.

• Mac OS
Set the option configuration correctly in [Chooser] in the 
Apple menu.

Status Possible Causes, Descriptions, and Solutions
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PDF Direct Print is not executed 
(PDF file is not printed).

Set the value in [RAM Disk] on the [PS Menu] to 2 MB or more.

Reference

For details about RAM Disk, see p.89 “PS Menu”.

When printing a PDF with a password set, set the password 
of the PDF file using the [Change PDF Password] menu in [Gen-

eral Features] or Web Image Monitor.

Reference

For details about [Change PDF Password], see p.85 “General 
Features”.

For details about Web Image Monitor, see Help.

PDF files not allowed to be printed by the PDF file security 
setting cannot be printed.

As a result of printing using 
PDF Direct Print, characters are 
missing or misshapen.

Before printing, embed the font in the PDF file to be printed.

The paper size appears on the 
control panel and printing is not 
performed with PDF Direct 
Print.

When using PDF Direct Print, printing will be performed 
only when paper of the size set within the PDF file is loaded. 
When a message indicating a paper size appears, either load 
paper of the indicated size in the paper tray or perform Form 
Feed.

If [Tray Paper Size: Paper Feed Tray] in the online print feature 
menu is set to [Auto Detect], printing proceeds even if the size 
of the paper loaded in the paper feed tray differs from the 
page size of the PDF file.

The printing data is left in the 
machine's input buffer.

Do not use NetWare to configure form feed. Form feed is 
controlled by the printer driver on Windows. If NetWare 
form feed is configured, the printer may not print properly. 

Follow the procedure below to disable form feed according 
to the operating system used:

• Under Windows 95/98/Me, clear the [Form feed] check 
box on the [Printer Settings] tab in the printer properties di-
alog box.

• Under Windows 2000/XP, Windows Server 2003, or 
Windows NT 4.0, clear the [Form feed] check box on the 
[NetWare Settings] tab in the printer properties dialog box.

Status Possible Causes, Descriptions, and Solutions
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Note

❒ A PostScript error could mean that the PostScript data is erroneous or that
there is a lack of memory. Some PostScript errors can be avoided if the mem-
ory is expanded. If you still cannot print as expected, consult your sales or
service representative. For information on your nearest sales or service repre-
sentative, check with the shop where you purchased this printer.

❒ The following is the memory assigned for PostScript.

General memory 128 MB (64 + 64 MB, 
Factory settings)

192 MB (64 + 128 MB) 320 MB (64 + 256 MB 
)

Assigned memory 15.0 MB 27.0 MB 47.0 MB
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6. Using the Control Panel

Though the factory default settings of the printer are suitable for most printing
jobs, “Online Print Features” menu gives you access to a number of settings that
control basic printer operations. The Online Print Features settings you make are
retained even when you turn off the printer.

Reference

For more information about settings other than the Online Print Features, see
the Operating Instructions.

Online Print Features Menu

There are following items in the “Online Parameters” menu.

• General Features

• List / Test Print

• Host Interface

• PS Menu

• Adminstrator Tools

You can select the functions in the following table:

*1 Appears when the PostScript board is installed.

 Menu  Function menu

General Features Hold Data-in

Tray Paper Size: Paper Feed Tray

Custom Paper Size: Paper Feed Tray

Print Size Priority

Memory Over Flow

Cycle Setting

Spool Printing

Change PDF Password

Print Error Report

List / Test Print Configuration Page

PDF Configuration / Font Page

PS Configuration / Font Page

Host Interface I/O Buffer

I/O Timeout

PS Menu *1 Data Format

RAM Disk

Administrator Tools Return to Defaults
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Adjusting Online Print Features

A Press the {User Tools} key.

B Press [Online Print Features].

C Select the item you want to change, and then press [OK].

DMake any setting you require, and then press [OK].

Note

❒ To change the value entered, press the {Clear/Stop} key before pressing the
[OK] key. Then enter the new value.

❒ Press [Cancel] to return to the previous menu without changing any data.

E Press the {User Tools} key to return to the standby display.

Note

❒ The settings are not canceled even if the main switch is turned off or the
{Clear Modes} key is pressed.

❒ You can also return to the standby display by pressing the [Exit] key.

AJK135S
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Online Print Features Settings

General Features

❖ Hold Data- in 
You can select the online print mode. You can set whether the machine accept
or reject the online print data from the computer. 

Note

❒ Default is Off.

❒ Set the mode “On” to reject the online print.

❒ Set the mode “Off” to accept the online print.

❖ Tray Paper Size: Paper Feed Tray
You can select the size of the paper loaded in the paper feed tray.

Note

❒ Default: Auto Detect

❒ The machine cannot detect the following paper size automatically. When
printing on the following size, select the desired paper size on “Tray Paper
Size: Paper Feed Tray” menu before printing. 

• A5K, HLTK, 8KL, 16KLK

❖ Custom Paper Size: Paper Feed Tray
You can spesify the custom paper size of the paper loaded in the paper feed
tray.

Note

❒ Default: 210mm x 297mm

❖ Print Size Priority
You can select either the paper size specified using the printer driver or the
paper size specified using the control panel.

Note

❒ Default: Machine Size

❖ Memory Overflow
You can specify whether or not to print an error report when a memory over-
flow occurs.

Note

❒ Default: Do not Print
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❖ Cycle Setting
You can select the Cycle Setting mode.

Note

❒ Default: Auto Cycle

❖ Spool Printing
You can select the Spool printing mode.

Note

❒ Default: Off

❖ Change PDF Password
Set the password for the PDF file executing PDF Direct Print.

Note

❒ Default: Not Set

❖ Print Error Report
You can specify whether or not to print an error report when a RPCS error or
PostScript error occurs.

Note

❒ Default: Off

List / Test Print

❖ Configuration page
You can print the system controller data.

❖ PDF Configuration Page
You can print the controller’s PDF font list.

❖ PS Configuration Page
You can print the controller’s PostScript font list.
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Printing the configuration page

A Press the {User Tools} key.

B Press [Online Print Features].

C Select [List / Test Print] .

D Press the type of configuration page you want.

Comfirmation massage appears.

E Press[Yes].

The configuration page is printed.

Interpreting the configuration page

System Reference

❖ Printer ID
Displays the serial number assigned to the board by its manufacturer.

❖ Total Memory
Displays the total amount of memory (SDRAM) installed on the printer.

❖ Firmware Version

• System Version
Displays the version number of the system firmware.

• Engine
Displays the version number of the engine.

• Panel Version
Displays the version number of the panel.

❖ Controller Option
This item(s) appears when the controller option(s) is installed.

AJK135S
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❖ Printer Language
Displays the version number of the Printer Description Language.

❖ Options
Displays the optional trays installed.

Paper Input

Displays the settings made under the Print Size menu.

System

Displays the settings made under the System menu.

PS Menu

Displays the settings made under PS Menu.

PDF Menu

Displays the settings of PDF Resolution.

Host Interface

Displays the settings of I/O Buffer and I/O Timeout.

Network Setup

Displays the settings made under the Interface menu.

When DHCP is active on the network, the actual IP address, subnet mask and
gateway address appear in parentheses on the configuration page.

Interface Information

Displays the interface information.
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Host Interface

❖ I/O Buffer
Sets the capacity of the reception buffer.

Note

❒ Default: 128 KB 

❖ I/O Timeout
Sets the time to enable the interface after data stops being received. When the
time set here is exceeded, the printer will not receive further data via the in-
terface.

Important

❒ If the set time is too short, a time out might occur while one data is being
received. As a result, data from another interface might cut in and be print-
ed, or the emulation retrieval might start to replace the emulation before
the data is completely received.

Note

❒ Default: 15 seconds

PS Menu

❖ Data Format
You can specify the data format for PostScript print jobs.

Note

❒ Default: Binary Data

❒ Under Mac OS X, select “TBCP” when you print with a USB connection.

❖ RAM Disk
You can select the RAM disk capacity for PostScript.

Note

❒ Default: 4 MB

Administrator Tools

❖ Return to Defaults
You can reset the settings back to their defaults. However, the “IP Address”,
“Network”, and the “Ethernet Speed” settings remain in effect.
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7. Appendix

Printing a PDF File Directly

You can send PDF files directly to the printer to print without opening a PDF ap-
plication.

Limitation

❒ To use this function, the PostScript board must be installed on the printer.

❒ This is possible for genuine Adobe PDF files only.

❒ Version 1.3, 1.4, and 1.5 PDF files are compatible.

❒ Transparency and JBIG2 (functions of PDF version 1.4) are not compatible.

❒ PDF version 1.5 only functions are not compatible. 

❒ When you make the [Layout] setting using the printer driver, be sure to select
[Portrait] or [Landscape] according to the actual orientation of the PDF print
job.

Printing Method

❖ Using DeskTopBinder Lite/professional
PDF files registered with DeskTopBinder Lite/professional can be sent di-
rectly to the printer for printing.

Note

❒ The RPCS printer driver must be installed. 

❒ Use DeskTopBinder Lite on the provided CD-ROM labeled "Document
Management Utility". PDF file direct printing is supported only by Desk-
TopBinder Lite/professional Version 3.1.1.0 or later.

❒ PDF Direct Print settings can be made from PDF Direct Print properties. 

❒ To print password-protected PDF files, you must do the following:

• Enter the PDF password using PDF Direct Print properties. 

• On the control panel, select [Change PDF Password] on the [Online Print
Features] in the User Tools menu to set the PDF password.

Reference

For details, see DeskTopBinder Lite/professional Help.

To check which version of DeskTopBinder Lite/professional you have, see
DeskTopBinder Lite/professional Help or the DeskTopBinder Lite Readme
file on the provided CD-ROM labeled "Document Management Utility".
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❖ Using commands
From Windows, you can print PDF files directly, using commands such as
“ftp” and “lpr”.

Reference

• For more information about printing using commands under Windows,
see “Printing Files Directly from Windows”, Network Guide.
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Specifications

This section contains the machine's electrical and hardware specifications, in-
cluding information about its options.

*1 To use NetBEUI, use the SmartDeviceMonitor port.

Component Specifications 

Resolution • RPCS
Type 1: 600 dpi
Type 2: 400 dpi

• PostScript 3
Type 1: 600 dpi
Type 2: 400 dpi

Printing speed 60-135 ppm

Interface Standard:

• USB 2.0 interface

• Ethernet interface (100BASE-TX/10BASE-T)

Option:

• IEEE 802.11b wireless LAN interface

• IEEE 1284 parallel interface

Network protocol TCP/IP, IPX/SPX, NetBEUI *1 , AppleTalk

Printer language Standard: RPCS

Option: PostScript 3

Fonts Standard: Arial

PostScript 3 (Option):136 fonts (Type 2:24, Type 14:112)

Memory 128 MB (64 MB + 64 MB)

Operating systems sup-
ported by this printer

Windows 95/98/Me/2000/XP

Windows Server 2003

Windows NT 4.0

Mac OS 8.6 to 9.2

Mac OS X

Required network cable 100BASE-TX/10BASE-T unshielded twisted-pair (UTP, Catego-
ry/Type5) cable.
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Options

Limitation

❒ Only one optional interface can be installed in the printer at a time. Therefore,
the IEEE 802.11b interface unit and the IEEE 1284 parallel board cannot be in-
stalled concurrently.

IEEE 802.11b I/F Unit Type 1

❖ Transmission spec.:
Based on IEEE 802.11b (wireless LAN)

❖ Protocol:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

Note

❒ SmartDeviceMonitor and Web Image Monitor are supported.

❖ Data transfer speed:
Auto select from below speed
1Mbps, 2Mbps, 5.5Mbps, 11Mbps

❖ Frequency range:

• Inch version:
2412-2462 MHz (1-11 channels)

• Metric version:
2412-2472 MHz (1-13 channels)

❖ Transmittable distance:
1Mbps 400 m *1 

2Mbps 270 m *1 

5.5Mbps 200 m *1 

11Mbps 140 m *1 

*1 These figures are a guideline for outdoor use. In general, the transmittable dis-
tance indoors is 10-100 m, depending on environment.

❖ Transmission mode:
802.11 ad hoc, ad hoc, and infrastructure mode
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IEEE 1284 Parallel Board Type 1

❖ Transmission spec.:
IEEE 1284

❖ Required cable
Standard IEEE 1284 compliant Micro Centronics 36 pin cable

Note

❒ Use the cable supplied with this machine.

PostScript3 Board Type 2

Reference

PostScript3

Memory Unit TypeC 128MB/256MB

❖ Module Type:
SO-DIMM (Small Outline Dual-in-line Memory Module)

❖ Memory Type:
SDRAM (Synchronous Dynamic RAM)

❖ Number of Pins:
144 pins

Extension HDD Type 1

❖ Data Capacity
20 GB
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